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ChemLab Simulations

ChemLab for windows is an interactive simulation of a chemistry lab. Common Lab equipment and 
procedures are used to simulate the steps involved in performing a chemistry lab experiment. Each lab
simulation is contained in a separate simulation module, thus many different labs are possible using a 
common lab interface. 

A lab simulation module contains code and resources, such as chemical list, indicator list, available 
menu options and instructions specific to each lab. New lab modules can be added to ChemLab by 
copying them to the program directory. These lab modules are in fact extensions of the main ChemLab 
program, which is basically    a common interface for them.

Selecting a Lab Simulation:

A lab module is selected at start-up and when a new file is created or by selecting the lab option. The 
simulation dialog box presents a list of available labs and a short description of each one. To select a lab, 
click on the title of the lab you wish to perform and press OK.    Clicking cancel will load the generic lab 
simulation.

When an existing file is opened it automatically loads the appropriate lab module. If that lab is not 
available a generic lab module is loaded which allows the viewing of the file. 

In addition to selecting simulation modules, the user may also want to create their own labs using a 
Lab Wizard tool. These Lab Wizard tools can be viewed by selecting the Lab Wizards tab on the 
simulation dialog box. Selecting a Lab Wizard will take the user through the step-by-step process of 
creating a new custom lab called a UDL (User-Defined Lab) simulation. The stoichiometry    Lab Wizard
may be launched directly from the ChemLab by selecting Create New UDL… under the File Menu.
These UDL simulations will then appear in the list of available lab modules. The UDL file name will 
appear in the UDL file column. Once you have opened a UDL, it may be edited from ChemLab by 
selecting Edit UDL file … under the File Menu. 





Getting Started
When ChemLab is started or a new file is created the simulation dialog box will open. From this dialog 
box pick a simulation module to load. This will load the text window with the instructions necessary to 
perform the lab. Read the lab introduction in the introduction text window. The introduction will explain 
the basic science behind the lab. After reading the lab introduction read the procedure. To select the 
procedure click the procedure tab above the text window. In the procedure you will find the basic steps 
to complete the lab, you should first read the procedure completely before attempting the lab. If you are
not sure how to perform a certain action check the lab manual or help for directions. Then perform the 
lab following the steps in the procedure. While performing the procedure you can record your 
observations in the observation text window, these will be saved in the ChemLab file.



The Organization of ChemLab
ChemLab consists of    two windows, a text and Lab window, divided by a splitter bar. The Lab window 
displays the animated lab simulation. Objects in the form of lab equipment are added to this window.    
These objects can be added and acted upon by using the Chem toolbar or the main menu commands.

The text window serves as the center for textual documentation in ChemLab. It is divided into 3 
windows; A read-only introduction    and lab procedures, and a user writeable observation window. 
These windows are selected by pressing the text tab bar, located just above the text window. 
The observation window allows the user to perform paragraph and character level formatting. These 
formatting options can be selected using either the text Toolbar, located just above the text window, or 
by using the text edit menu commands found in the edit main menu. 



Lab Equipment
Lab equipment    is added to the Lab window by either selecting from the chem toolbar, equipment 
menu, right mouse context popup menu, or additionally lab equipment can also be added through the 
chemicals dialog box by specifying a new lab container.

ChemLab provides the following pieces of lab equipment: 

Beaker : a wide mouth, thin walled containers with a projected lip used widely in laboratory chemistry.    ChemLab provides a 
100ml and 600ml beaker. They can be added to the lab space by pressing the toolbar beaker button (100ml), selecting the 100 
or 600ml menu items from the equipment menu or right click on the lab space and selecting the beaker menu item from the 
popup context menu.

Buchner funnel    : a funnel with a flat circular base    perforated with small holes    used for filtering with suction. In ChemLab a 
buchner funnel is added by first selecting an erlenmeyer flask and then picking the buchner funnel from the toolbar, equipment 
menu or right-mouse-button context menu. To remove the funnel, do the same. If any solid is present in the filter a dialog box will
appear asking whether you wish to discard or keep and place it another container.    

Bunsen burner      : a gas burner used in laboratories. Consists of a metal tube with a valve for controlling the air-fuel mixture. In 
ChemLab the bunsen burner is added by selecting the bunsen burner button from the tool bar, equipment menu or right-mouse-
button context popup menu. If a container is selected when the bunsen burner button or menu item is selected a burner will be 
added just below the selected container. Lab equipment containers, which allow heating, that are place directly above a bunsen 
burner, will receive a fixed amount of heating from burner. The amount of heat transfer by a bunsen burner can be varied by 
changing the burner heat in the equipment option dialog box. 

Buret    : a graduated glass tubes with a stopcock valve used for transferring precisely measured liquid volumes. Used in 
volumetric analysis in laboratory chemistry. In ChemLab a 10ml and 50ml buret are provided. They can be added to the lab 



space by pressing the toolbar buret button, selecting the buret from the equipment menu or right click on the lab space and 
selecting the buret menu item from the popup context menu.    

A titration dialog box is opened when a new buret is added. The titration dialog box is used to control the rate of flow leaving the 
buret. A slider control in the dialog box labeled stopcock is used for this purpose. If an existing buret is selected when the buret 
button or menu is pressed no new buret will be added, rather the titration dialog box will then refer to the previously selected buret. 
To identify which buret the titration dialog box refers to; the buret’s label value is added to the dialog box’s menu bar. Note, only one
titration dialog box can be opened at a time. The titration dialog box also updates the current volume of the buret to the nearest 
tenth of a ml and can be used to record the start and end-points of a titration.

Calorimeter    :    is an instrument for determining the amount of heat evolved, transferred or absorbed. In ChemLab it consists of
a closed insulated vessel with a thermometer. To add a calorimeter to ChemLab select the calorimeter menu option in the 
Equipment main menu or use right-mouse-context button. The calorimeter has a volume of 250ml and will be open when first 
added. To close a calorimeter, select it and press the thermometer tool bar button. This will add both a thermometer and a cork 
top to calorimeter. Doing this a second time will remove the thermometer and open the calorimeter. Note: the calorimeter will only
be available for those experiments in which it is used. So the menu option will often appear grayed out.

 

Erlenymeyer Flask :    a flat base conical flask with a narrow neck. ChemLab provides a 100ml erlenmeyer flask. They can be 
added to the lab space by pressing the toolbar erlenmeyer flask button, selecting erlenmeyer flask from the equipment menu or 
right click on the lab space and selecting the erlenmeyer flask menu item from the popup context menu.



Evaporation Dish      : is short wide mouth container with thick walls. ChemLab provides an evaporation dish with a volume of 
100ml. They can be added to the lab space by pressing the toolbar evaporation dish button, selecting the evaporation dish from 
the equipment menu or right click on the lab space and selecting the evaporation dish menu item from the popup context menu.

Florence flask      : is a round container with a long neck and narrow mouth. ChemLab provides an florence flasks with a volume 
of 100ml. They can be added to the lab space by pressing the toolbar florence flask button, selecting the florence flask from the 
equipment menu or right click on the lab space and selecting the florence flask menu item from the popup context menu.

Graduated cylinder      : is a tall cylindrical container with a finely marked scale, used for precisely measuring out liquid volumes.
In ChemLab a 10ml and 50ml graduated cylinder are provided. They can be added to the lab space by pressing the toolbar 
graduated cylinder button (100ml), selecting the graduated cylinder from the equipment menu or right click on the lab space and 
selecting the graduated cylinder menu item from the popup context menu.

Stirring Rod    : is a glass rod used for mixing. ChemLab allows the addition of a stirring rod for mixing to selected lab containers
with some contents. The stirring rod may be added to a single selected item by pressing the stirring rod button on the toolbar, 
selecting stirring rod from the equipment menu or from the popup context menu. A user can also remove an existing stirring rod 
from a container by this same process. The stirring rod will remain in a container for only a few seconds; to continue stirring the 
user must re-select the stirring rod.



Test Tube  : a plain or lipped thin glass tube closed at one end. ChemLab provides an test tube with a volume of 50ml. They can 
be added to the lab space by pressing the toolbar test tube button, selecting the test tube from the equipment menu or right click 
on the lab space and selecting the test tube menu item from the popup context menu.

Thermometer  : is a instrument for measuring temperature, it consist of a closed narrow graduated tube with a bulb at one end. 
The tube contains a liquid, such as mercury, whose volume varies with temperature. Temperature is indicated by the height of 
the mercury column within the thermometer. 

ChemLab allows the addition of a thermometer to selected lab containers. The thermometer may be added to a single selected 
item by pressing the thermometer button on the toolbar, selecting    thermometer from the equipment menu or from the popup 
context menu. A user can also remove an existing thermometer from a container by this same process. The recorded 
temperature is indicated by the height of the liquid in the tube and additionally by a text field at the top of the thermometer. The 
scale can be changed from Kelvin, Celsius or Fahrenheit by selecting the temperature scale setting in the equipment options 
dialog box.

Watch glass  : is a short circular glass container, used for measuring out solids and other miscellaneous tasks in the lab. 
ChemLab provides an watch glass with a volume of 50ml. They can be added to the lab space by pressing the toolbar watch 
glass button, selecting the watch glass from the equipment menu or right click on the lab space and selecting the watch glass 
menu item from the popup context menu.

Weighing scale  : are instruments used for weighing mass. ChemLab does not provide weighing scales but instead will show 
the sample weight in grams (that is the weight of only the contents of a container) of a selected container in a highlighted text 
field below the container. The sample weight may be added to a single selected item by pressing the scales button on the 
toolbar, selecting scales from the equipment menu or from the popup context menu. A user can also remove an existing sample 
weight from a container by this same process.





Using the mouse

ChemLab uses the mouse to select lab equipment for a number of actions:

Picking a single piece of lab equipment, either by single left mouse click or dragging (holding down the left mouse button while 
moving the mouse). Selecting a piece of lab equipment allows adding chemicals, water, thermometer, scale, stirring rod, bunsen 
burner, a funnel to a flask and decanting or pouring.

Right mouse button      :
Pressing the right mouse key will open a context menu. If the right mouse is clicked over a lab object a menu listings actions that
can be performed upon that object will appear. If clicked over the workspace; a menu will appear that list possible lab additions 
that can be made to the workspace.

Double clicking mouse      :
Double clicking the left mouse button on a piece of lab equipment will open the chemical properties dialog box . 

Double clicking on the label of a piece of lab equipment allows it to be edited.

Selecting two or more objects      :
To select two or more lab objects,    drag the mouse around the objects while holding down the left mouse key, then release the 
mouse key.    A selection rectangle will then enclose the selected objects.

Combining and Removing Equipment :
Selecting 2 pieces of lab equipment, which fit into each other, allows combining of lab equipment    (arrange menu). Combining 
places one piece of lab equipment into another, this can be used to arrange a cooling or hot water bath. To remove two 
previously combined pieces of lab equipment select the combined object and select the remove menu option from the arrange 
menu or pop-up context menu.

Selecting 2 or more objects also allows grouping of objects together.

      





ChemLab Procedures
Positioning Lab Equipment

ChemLab tries to create the feel of a lab by using the position of certain lab equipment relative to other lab equipment. This is 
seen in decanting, or pouring, titration and heating with the bunsen burner. 

Pouring/decanting        : 
Pouring or decanting, involves selecting a piece of lab equipment, positioning its left side over the receiving container and 
selecting the decant button from toolbar or decant/pour menu item from the procedures menu or from the right-mouse-button 
context menu. Note: liquid is first transferred in this process, to allow separation.

Heating :

Similarly to heat an object with a bunsen burner, position the burner under that object. 



Adding Chemicals
To add chemicals to a container first select the container and then select the    chemicals button from 
the toolbar or chemicals menu item from either the main menu or the right-mouse-button context menu.
This will open up a chemicals dialog box. The chemicals dialog box allows the users to add chemicals 
to the selected item or add chemicals to a new item. It will also allow the user to change the selected 
containers size and type. Select the desired chemical from the chemicals drop-down combo box. Enter
the desired mass or volume of chemical needed and press OK.



Adding Indicators 
Indicators are substances that signify the completion of a chemical reaction with a color change. To 
add an indicator to a    piece of lab equipment, select it and then press the indicator menu option in the 
Chemical main menu or the right-mouse-button context menu. This will open a dialog box which list 
available indicators and their color change characteristics. Not all labs use indicators so this menu will 
often appeared grayed. 

For those labs that do use indicators, select the desired indicator from the list of available indicators 
and enter the number of drops to add (from 0-10) and press OK. Indicators are generally ignored by 
ChemLab except to flag a Chemical reaction, so they will appear to have no weight or volume.



Adding Water 
Water is added to a selected lab item by using either the toolbar water button or the water dialog box. 
To open the water dialog box, select the water menu item in the chemicals menu or the water menu 
item with the right-mouse-button context menu. Water may also be added through the Chemicals 
dialog box. The toolbar button will only add    water at room temperature to a selected item to the next 
graduation on the container. The water dialog box also allows the users to add ice water, which is used
to create ice baths. The water dialog box also only adds water in increments.



Adding a Label 
ChemLab allows a user to add a label to a lab container, along with a short annotated note. By 
selecting a lab container lab and then selecting the    label menu item in the procedures menu or right-
mouse-button context menu or by double clicking on the container’s label area.      This will open up the
label dialog box, which allows the user to enter a 2 letter label, which is visible on the container and a 
short annotated note, which can be viewed from the label dialog box.



Chemical Properties Dialog Box

The Chemical Properties dialog box shows the current chemicals and their states in a piece of lab 
equipment.



Saving files
Lab experiments may be saved to file for latter use (file format *.lab). To save a file a user can select 
the toolbar file button, or file’s menu save or save as menu selections.



Printing Files
ChemLab files may be printed by selecting the print toolbar button or by selecting the print menu in the 
file main menu. Printing will print both the observations and the lab objects from the lab window.



Setting Options
ChemLab allows the setting of a number of options including: equipment options,    current lab module, 
and window settings. These options are available under the options main menu. 

Equipment options are set in the Equipment option dialog box. These options include the settings for 
the heat transferred by the bunsen burner, the size of the text font used in main lab window graphics; 
such as the equipment label, and the setting for the temperature scale used. These options once set 
are preserved until changed again.

Window option settings including whether both the main lab window and the text window are visible or 
only the lab window. This option can be set by selecting the toolbar button or the “Both lab & text“ and 
“Lab Only” main menu options.



Warnings
Lab instructions included with ChemLab have been modified and simplified for purposes specific to 
ChemLab. They are not suitable for use in an actual lab setting and should not be used as a substitute 
for lab documentation and instructions developed for actual experimentation.    



Feedback

Please send us your comments on this software, bugs, other problems, suggested improvements, and 
experiments you think could work in this format. 

Our e-mail address is :

info@modelscience.com 

Also check out the Model Science Web Site for new developments, down-loadable software and 
product information:    

http://www.modelscience.com

You may launch your web browser by selecting Model Science Web Page from the Help Menu.



Updates
Registered owners of ChemLab1.2 may download ChemLab program updates and additional 
simulation files free of charge.

All you need is your ChemLab serial number. It may be found in the About ChemLab dialog box under 
the Help Menu. Write down your serial number and go the Updates web page located at:

http://www.modelscience.com/updates.html

You can get there by entering the above URL directly into your web browser. You may also select 
Model Science Web Page from the Help Menu, which launches your web browser, and then link to the 
Updates page from there.

There you will be asked to submit your serial number. After verification, you will be able to download 
the update file.




